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INTRODUCTION 
The ENVIROMUX-MNG is intuitive graphical software that provides an easy-to-use, unified interface for both monitoring and 
configuring up to 3,000 ENVIROMUX-SEMS-16, ENVIROMUX-SEMS-16U, ENVIROMUX-2D(REV C only), 
ENVIROMUX-5D, ENVIROMUX-16D, ENVIROMUX-MICRO-T(RHP), ENVIROMUX-1W and IPDU-S4/S8 units (UNITS) and 
all connected sensors.   The software is split into two parts, the Server (to actively poll all UNITS for status information and 
alerts) and Client (to communicate with the Server from any location to read statuses and make configuration changes).   
 
A License Activation Key controls how many UNITS can be monitored and configured through the Server, and a License 
Activation Key supporting up to 10, 50, 100, 500 or 3000 UNITS is available from http://www.networktechinc.com/enviro-
rems-gui.html.   

 

Features:  

 Units may be monitored and configured individually or in a group.  

 Display values and status for individual sensors or list of sensors.  

 NTI will provide customer, without charge, copies of any appropriate updates/enhancements for 12 months. This 
software update service is optionally extendable every twelve months for 20% of the then current list price. 

 Client/Server architecture  

o Server application actively polls all UNITS for status information as well as listens for alerts from all UNITS.  

o Client application communicates with the Server to read statuses and to deploy configuration changes. 

 

Server and Client Requirements:  

 Support Windows Vista/Windows 7/Windows 8/Windows 10/Server 2003/2008/2012, Solaris, Linux, FreeBSD, and MAC 
OS 10.5 or later.  

 Requires Java Runtime Environment 1.6 or later.  Version 1.8 or later is recommended.  

Note: If Java Runtime Environment 1.8 or later is installed, the ENVIROMUX-xD units must be running firmware 
version 2.35 or later and the ENVIROMUX-SEMS-16 units will no longer be compatible with the ENVIROMUX-MNG. 

 Requires firmware version 3.1 or later in ENVIROMUX-SEMS-16 units.  

To maintain compatibility with ENVIROMU-SEMS-16 units you must be running Java version 1.7 or earlier and 
ENVIROMUX-xD firmware version 2.34 or earlier.  

 Requires firmware version 1.2* or later in ENVIROMUX-16D units.  

 Requires firmware version 2.0* or later in ENVIROMUX-5D units. 

 Requires firmware version 2.3* or later in ENVIROMUX-2D units (REV C only (models with two power inputs)).  

 Requires firmware version 1.3 or later in IPDU-S4/S8 units.  

 Requires firmware version 3.2 or later in ENVIROMUX-MICRO-T(RHP) units.  

 Requires firmware version 2.5 or later in ENVIROMUX-1W units 

*Note: In order to fully use the features in ENVIROMUX-MNG Version 3.0,  all ENVIROMUX-xD units must be using 
firmware version 2.46 or later.  
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Below minimum requirements assume CPU with physical cores (rather than virtual) and an OS similar to MS Windows or Linux 
with minimal usage from other user applications. 
 
Server Configuration: 
1 - 20 UNITS, 1- 5 clients: 
Minimum requirements: dual core CPU with 2 GB RAM 100 Mbps network 
Recommended Configuration: Quad core CPU with 4 GB RAM 100 Mbps network 
 
20 - 80 UNITS, 5 - 15 clients: 
Minimum requirements: Quad core CPU, with 4 GB RAM 100 Mbps network 
Recommended Configuration: 8 core CPU with 8GB RAM 100 Mbps network 
 
80 - 300 UNITS, 10 - 25 clients: 
Minimum requirements: 8 core CPU with 8GB RAM 100 Mbps network 
Recommended Configuration: 12 core CPU with 16 GB RAM 1 Gbps network 
 
300 - 700 UNITS, 15 - 35 clients: 
Minimum requirements: 12 core CPU with 16 GB RAM 1 Gbps network 
Recommended Configuration: 20 core CPU with 24 GB RAM 1 Gbps network 
 
Client Configuration: 
1 - 20 UNITS: 
Minimum requirements: dual core CPU with 2 GB RAM 100 Mbps network 
Recommended Configuration: Quad core CPU with 4 GB RAM 100 Mbps network 
 
20 - 80 UNITS: 
Minimum requirements: dual core CPU with 2 GB RAM 100 Mbps network 
Recommended Configuration: Quad core CPU with 8 GB RAM 100 Mbps network 
 
80 - 300 UNITS: 
Minimum requirements: Quad core CPU with 8 GB RAM 100 Mbps network 
Recommended Configuration: 8 core CPU with 16 GB RAM 1 Gbps network 
 
300 - 700 UNITS: 
Minimum requirements: 8 core CPU with 16 GB RAM 1 Gbps network 
Recommended Configuration: 10 core CPU with 20 GB RAM 1 Gbps network 
 
If installing over 700 UNITS to manage from a single machine, contact NTI for custom setup. 
 
 
 
Server and Client Roles and User Access: 
 
The Server is used to add and manage UNITS to be monitored or delete them from the monitoring list.   The Server is also used to 
manage the Users that have access to the ENVIROMUX-MNG and the UNITS monitored by it.   
 
        Only the root administrative user can access the Server.     
 
        The server is not used to view the status of sensors attached to UNITS. 
 
 
The Client is used by Users to monitor and manage sensors connected to UNITS   It can also be used by the root administrative 
user to manage the server.  
 
         The root administrative user can login from the Client software to remotely control the Server with the same controls they  
          would have if connected through the Server software.   The root administrative user does not have access to view the status   
          of attached sensors.  
 

Users with administrative rights (not user “root”) can create projects that monitor specific UNITS connected to the Server, 
manage sensors connected to UNITs,  and manage the users that have access to individual UNITS being monitored.    
 
Users without administrative rights can only use the Client to view the status of any sensors connected to any UNIT.     The 
standard user cannot make any changes to configuration.      
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MATERIALS 
 
Materials supplied with this package:  
NTI ENVIROMUX-MNG ENVIROMUX Management Software including:  
 

 mng-srvr-vx-x.zip file (for the management server) (vx-x = the version number) 
 mng-clnt-vx-x.zip file  (for client PCs) (vx-x = the version number) 
 Adobe pdf file of this manual 

 
 
 

LIMITATIONS 
 
 UNITS must be individually connected to the LAN (not cascaded) in order for the ENVIROMUX-MNG to function. 

 
 The Management Software: 

 cannot simulate alerts 

 cannot change IP addresses of the UNITS 

 cannot save or restore individual UNIT configurations from within the management software 

 

 The Server application is licensed to be applied to one CPU and will only work on the CPU with the Machine ID (MAC 
address) supplied at the time of license issue.   To move the Server application to a different CPU, contact NTI to request an 
updated license.  

 

 There is no limit to the number of Client applications that can be installed on CPUs to access the Server and connected 
UNITS.     

 

 Multiple Server applications can monitor UNITS at the same time with no ill effects.  

 

 There is no limit to the number of Clients that can access the Server at a time  
 
 There is no limit in the program to the number of users that can be configured to use the Client to access the Server.    The 

number of users configured will only be limited by the amount of memory in the server hosting the program.  
 
 There is limited support for the following sensors: 

  ENVIROMUX-ACDC-LM 
  ENVIROMUX-DCLM-6 
  ENVIROMUX-ACLM-3P480 

You can only monitor, acknowledge or dismiss an alert for these sensors.  Configuration of these sensors from the 
management software is not completely supported as of this version.  
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INSTALLATION 
 
The ENVIROMUX-MNG enables an administrator to manage multiple UNITS (up to 3,000) either from a central CPU acting as a 
server or from client CPUs.  In order for a client CPU to manage UNITS, the client must have access to this server.    
 
To install the Server software on a computer, unzip the mng-srvr-vx-x.zip file received via email to a directory where the 
software will run.   (vx-x will be the version number of the software.)   
 
TIP: At this time, you might want to place a shortcut on the desktop to run the semsmanagersrvr.jar file. (In Windows, 
right-click the .jar file, click “Send To”, click “Desktop (create shortcut)”.) 
  

Note: Ensure that the server firewall allows TCP ports 9000, and 9001 access.  If a UNIT is 
behind a firewall, ensure UDP port 161 and 162 (SNMP) and TCP port 6000 is accessible.  
 

Note: SNMP must be enabled in each ENVIROMUX Unit monitored for the ENVIROMUX-
MNG to receive and display sensor values.  
 
The ENVIROMUX-MNG also enables any PC (with Java installed and with access to the Server) to additionally manage the 
ENVIROMUX units.   The PC (Windows/Sun/Mac/Linux/etc) can access the Server via an Ethernet connection.  These PCs will be 
referred to as “clients” throughout this manual.  
 
To install the Client software on a computer, unzip the mng-clnt-vx-x.zip file received via email to a directory where the 
software will run.  (vx-x will be the version number of the software.) 
 
TIP: At this time, you might want to send a shortcut to the desktop to run the semsmanager.jar file.  (In Windows, right-
click the .jar file, click “Send To”, click “Desktop (create shortcut)”.) 
                                                         
Be sure that Java Runtime Environment 1.6 or later is installed on the server and each client.    This software can be downloaded 
from http://java.com/en/download/manual.jsp.  

Licensing 
After installing the server software and Java Runtime Environment (version 1.6 or later), the Server software can be opened by 
double-clicking on the SemsManagerSrvr.jar file in the directory mng-srvr-vx-x.zip  was unzipped to .   When you start the 
SemsManagerSrvr.jar file the first time the End User License Agreement will be presented.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                   Figure 1- End User License Agreement 

After reading the agreement, make sure “I agree with the above terms and conditions” has been selected and click on Next.  
 
You will then be presented with a license installation screen.  
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                                                            Figure 2- License Installation screen 

If you have not yet purchased the ENVIROMUX-MNG and are evaluating it, a temporary license to use it in conjunction with up to 
10 ENVIROMUX units for 30 days can be automatically generated.   After 30 days, the software will not work unless a valid 
permanent license is installed, or another temporary license can be generated, but all configuration settings will be lost.   Only the 
purchase and installation of a permanent license will avoid losing your configuration. 
 
For now, click on “Generate 30 days license” to access the ENVIROMUX-MNG menu.  

Note: See “Deactivate User Account Control” on page 6 before generating a temporary or activating a permanent license.  

To install a permanent license, you must have purchased the software and submitted for a license activation key.   Upon 
purchasing the software, you will receive a confirmation email that includes a product serial number for the software purchase.   
That number, combined with the Machine ID of the computer the Server software is on, will be required to apply for the License 
Activation Key. 

Note: It can take up to 3 business days after submitting your License Request Form to receive your License Activation 
Key. 

Get Machine ID 
With the Server software main menu now open, select “Help”  and “Install License”.     
 
 
 
 
 
 
 
 
 
 
 

                                     Figure 3- Server software-Install License tab 

 
The following image will open: 
 
 
 
 
 
 
 
 
 
 

        

 

                                                 Figure 4- License Activation screen 

 
The “Machine ID” of the computer is in the first line of the image (example above).   Write this down exactly as shown and enter it 
on the Registration and License Request Form found at   http://www.networktechinc.com/license-request-env.html .     
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                                        Figure 5- Registration and License Request Form 

Install Permanent License 
Within 3 business days, you will receive an email that includes a License Activation Key.   Enter the key with the characters 
exactly as they are in the body of the email in the block provided in the “Activate License” screen (Figure 4).   
With a proper entry of the License Activation Key, click on Activate.  The ENVIROMUX-MNG software should now be ready to 
use.  
 

NOTE: The Server application is licensed to be applied to one CPU and will only work on the CPU with the Machine ID 
supplied at the time of license issue.   To move the Server application to a different CPU, contact NTI to request an 
updated license.  
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Deactivate User Account Control 
 
In order to install the license (permanent or temporary) to your PC when running Windows 7 (or later) or Server 2008 (or later) you 
will need to temporarily deactivate User Account Control.    Otherwise, the license will not be able to be written to your registry and 
each time the ENVIROMUX-MNG Server is restarted it will have to be re-configured.     
 
 
To deactivate User Account Control: 

 Go to Control Panel of the Windows Operating System 
 Open User Accounts 
 Click on “Change User Account Control Settings” 
 Slide the button down to “Never notify”. 
 Click “OK” 
 Reboot the PC for this to take effect. 
 Activate the ENVIROMUX-MNG Management Software License 

                 

After activation you can change the account control setting back to their original settings. 

 
To deactivate User Account Control in Windows 10, you must first enable the hidden administrator account.  Then log 
into the Windows 10 PC as the “Administrator”  (not just an administrative user).   After deactivating User Account 
Control, remain logged in as “Administrator” and install the license.  
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From the Command Line 
If the Server software is unzipped to a CPU that operates strictly from the command line,  then the following commands will 
provide access to the Server in that environment : 
 
From the directory the Server software has been extracted to type: 
 
C:\ENVIROMUX-MNG>java -jar SemsManagerSrvr.jar root admin -config 
 
 
You will be prompted to accept the terms and conditions, type  Y and press <Enter>: 
 
Do you agree with above terms and conditions? (y or n): y 
A valid license key was not found on your system! 
 
Select an option: 
   Generate 30 days license    <1> 
   Install permanent license   <2> 
   Cancel                      <3> 
> 1 
 
The software will check for a license key.   

 If you already have one,  enter <2> to be prompted to enter it and simply copy and paste the key from the email 
message it was received on, or carefully type the key in.     

 If you don’t have a license key, enter <1> to generate a temporary 30 day license.   
 

Note: The terms and conditions will only be displayed until a temporary license is generated or a permanent license is 
installed.  After that, only the license status and command prompt (below) will follow the initial command to open the 
program.  

 
Once the license is entered, the command prompt will be ready to receive control commands to configure the server.  To see a list 
of commands the server will accept,  type <help>.    
 
 
C:\ENVIROMUX-MNG>java -jar SemsManagerSrvr.jar root admin -config 
Nb of allowed Enviromux units: 10 
Expires on: Sat Dec 29 16:57:10 EST 2012 
Type 'help' to view available commands 
> 
 
 
For more on server management from the command line and a list of commands, see page 13. 

 

Start the Server, Configuration is Done 
 
To start the ENVIRMUX-MNG server without going into the configuration mode, type the following at the command prompt:  
 
C:\ENVIROMUX-MNG>java -jar SemsManagerSrvr.jar root admin –nogui 
 
Note:  If you have changed the root user password, substitute the new password for “admin” in the string above.   
 
 
To stop the server, terminate the program using a command appropriate for your operating system (<Ctrl+c> for DOS, <kill> 
for Linux, etc). 
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SERVER MANAGEMENT 

Manage From the GUI (Graphical User Interface) 
Immediately after installing the license, and any time hereafter that you double-click on the semsmanagersrvr.jar file,  the 
server management software will open to the login screen.  The administrator is named “root”, and the root user will be prompted 
for a password.    
 

The default password is “admin”.  
Only the “root” user can access the “Server” side of the management 
software.    
 
 
Note: If the root user password has been changed and this 
installation is an update (rather than a new installation), the  
previous root password will not be changed with the updated 
software installation.  
 
 
 

                                                                                                                     Figure 6- Login to server 

The software will open to an empty list that will contain all connected UNITS to be monitored by the ENVIROMUX-MNG.  UNITS 
are easily added (by the “root” user only) using IP address, or DNS name (if so configured).   

Note:  The server will offer to update the root password of any UNIT that has a root password other than “admin”.   
Otherwise, these units will require a separate login when the server software is started. 

Add UNITs to Monitor 
 
To add a UNIT, click on the “File” menu and select “Add Unit”.   A window will open as shown below.   
 
Enter the IP address for the UNIT or the DNS name (if applicable) and press “Add”.  If the IP address is valid, the UNIT will appear 
in the server list.  If not, the message “cannot find unit” will be displayed below the “Add” and “Done” buttons.  When finished 
adding UNITs, click the “Done” button to close the window. 
 
TIP: If you don’t know the IP addresses of the UNITS to be monitored, you can use the included NTI Discovery Tool (page 
10 ) to identify them (provided they are all connected to the same LAN). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                 Figure 7- Add UNITS to monitor 

 
 

message when 
wrong IP address 
is supplied 
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Device Discovery Tool 
 

In order to easily locate the UNIT on a network,  the NTI Device Discovery Tool may be used.   A link to the Discovery Tool is 
provided on the web page that appears when you insert the instruction manual CD provided into your CD ROM drive.  Click on the 
link or browse the CD and click on the file discover.html .   This will open your browser and display the Device Discovery Tool 
page.    
 

Note: The Device Discovery Tool requires the Java Runtime Environment to operate.   
 

Note: The computer using the Device Discovery Tool and the ENVIROMUX must be connected to the same physical 
network in order for the Device Discovery Tool to work. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                                           

                                                              Figure 8- Device Discovery Tool page 

 
 
Use the Device Discovery Tool to display all NTI ENVIROMUX units on the network, along with their network settings.  Follow the 
instructions on the Device Discovery Tool page to use the tool and to change the device settings if so desired.  
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Add ENVIROMUX-MNG Users 
The administrator can add Users (as many as desired) that can access the MS and manage monitored UNITs.  The list of users is 
saved in the server but can be configured from any client location.  The “root” user can add users, define passwords, and assign 
administrator rights to a user if so desired.   Only listed users will have access to the ENVIROMUX-MNG.   
 
Users with administrative rights are also able to manage users in the individual UNITs, allowing them to add, edit, and 
delete users, as well as change passwords.   Only the root user can add additional UNITS to be monitored.  
 
To add a user, click on the “Users” menu item and select “Create New User”.  A window (see Figure 9) will open to define a User 
Name and Password.  Place a checkmark in the box next to “Administrative Rights” if you want this user to have control has 
described above.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                                  Figure 9- Create new user 

  

Edit ENVIROMUX-MNG Users 
The root user or users with administrative rights can make 
changes to a user’s password and change their status as an 
administrator.   Simply click on the “Users” menu and select “Edit 
User”.   A window will open where the desired user can be 
selected and boxes are available to change user settings or delete 
a user (see Figure 10). 
 
After making changes, press “Submit Changes” to have them take 
effect.  
 
After all changes are complete, press “Done” to exit the window. 
 
To delete a user, select the User name from the list and press 
“Delete”.    

Note: A password must be provided, even if it is only 1 
character.   

  

                                                                                                              Figure 10- Edit User 
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UNIT Loses Connection 
 
If a UNIT loses connection to the network, whether via power failure or Ethernet, the ENVIROMUX-MNG will indicate it.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                              Figure 11- UNIT has lost connection to network 

With the power or Ethernet connection restored, the software can be prompted to quickly reload the UNIT and restore sensing and 
management.  Simply right-click (with the mouse) on the client IP address and be prompted to either “Reload” the UNIT or 
“Delete” it from the list.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                         Figure 12- Reload UNIT to restore sensing and management 

 
 
 
 
 
 
 
 
 

UNIT has been disconnected



NTI ENVIROMUX-MNG Enterprise Environment Monitoring System Management Software 

 13

 

Manage From the Command Line 
To control the ENVIROMUX-MNG Server from the command line, enter the following command from the directory the server files 
have been unzipped to: 
 
C:\ENVIROMUX-MNG>java -jar SemsManagerSrvr.jar root admin –config 
 
Nb of allowed Enviromux units: 10 
Expires on: Sat Dec 29 16:57:10 EST 2012 
Type 'help' to view available commands 
 
Type <help> to view the available commands. 
 
>help 
    showid                   - Displays the machine ID for licensing 
    license <license_string> - Install license 
    del_license              - Remove current license 
    passwd                   - Change root password 
    listunits                - Lists the Enviromux units in the project 
    addunit <IPAddress>      - Add an Enviromux unit with IP address 
    delunit <IPAddress>      - Delete an Enviromux unit with IP address 
    listusers                - Lists the available users 
    adduser                  - Add a user account 
    deluser                  - Delete a user account 
    run                      - Exit config mode and start the server 
    exit                     - Exit 

 
If you have not yet applied for a permanent license, you will need to get the Machine ID for the License Request Form (page 6).  
Enter the command <showid> to see the machine ID. 
 
>showid 
00-0C-29-8D-43-09 
 
Write down the number presented for entry into the License Request Form.  
 
 
Once you receive the license, enter the command <license>  and the license string provided by NTI.  
 
>license <license_string> 
 
If, at some point, the ENVIROMUX-MNG Server is moved to a different CPU, the license will need to be updated to work with the 
new CPU.   To first delete the license from the initial server, enter the command <del_license>.  
 
Once the server is configured using the other commands to view, add, or remove ENVIROMUX Units to be managed and view, 
add, or remove users to have client access,  either enter <run> to start the server,  or <exit> to exit the configuration program. 
 
To start the server without entering the configuration program, enter the following command (substitute current password for 
“admin” as applicable):  
 
C:\ENVIROMUX-MNG>java -jar SemsManagerSrvr.jar root admin –nogui 
 
Nb of allowed Enviromux units: 10 
Expires on: Sat Dec 29 16:57:10 EST 2012 
Server started 
 
 
To stop the server, terminate the program using a command appropriate for your operating system (<Ctrl+c> for DOS, <kill> 
for Linux, etc). 
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USING A CLIENT 
With users and passwords assigned, a user can access the ENVIROMUX-MNG Management Software from any computer with 
the Client software loaded, provided the user has access to the computer the Server software is on.    There is no limit to the 
number of Clients that can access the Server at a time and there is no limit to the number of users that can be configured to use 
the Client to access the Server.     

User Connection 
After installing the Client software and Java Runtime Environment (version 1.6 or later), the Client software can be opened by 
double-clicking on the SemsManager.jar file (in the directory mng-clnt-vx-x.zip  was unzipped to).  A login screen will 
appear.  Enter the IP address of the server, a valid user name (other than root) and password and the manager screen will open. 
 
If you enter user name “root” and the password for “root”,  an administrative screen will open enabling the management of server 
settings.   See page 38 for more about this.  
 

Note: The client software will remember the last IP address entered, so this may not need to be repeatedly entered with 
each login unless the IP address of the server changes.  

 

 
 

 
 
 

 
 
 
 
 
 

                                                            Figure 13- Login at a Client 

 
The Client software will open to a blank window, wherein the user can create “Projects” that include groups of specific UNITs that 
are to be monitored.   Each user can create unique projects used to monitor all available UNITs, or just a portion of them.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                          

                                                            Figure 14- Empty list- no Projects defined yet 

 

IP Address of Server 

The Client program uses ports 9000 
and 9001.  As long as the server has 
those ports open any client can 
access the Server program. 
 
The Client PC's do not need any 
firewall ports open. 
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Project Management 
Each user can monitor any or all connected UNITs.  A project is made up of UNITs placed into a single group or can be broken up 
into category-specific groups for more organized monitoring. Any or all UNITs can be placed into each group.   Once they are 
defined, the list of groups and their included UNITs can be saved as named projects for easy recall later.  Multiple projects can be 
defined for each user.   From the “File” menu, a user can create a new project, open and existing project, or delete existing 
projects.  
 

Create a Project 
To create a new project go to the “File menu” and select “New Project”.    The word “<empty>”will be replaced by “New Project”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                             Figure 15- File Menu choices 

 
 
With the project “New Project” highlighted, go to “Edit” menu and select “Project Settings”.     A project window will open.   
FYI: The “Project Settings” selection is also used to edit an existing project.  
 
 
 
 
 
 
 
 
 
 
 
 

                                                           Figure 16- Select Project Settings 
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From the project window, click on the “New Group” button to add a group number under “New Project”.   Then click on the group 
name to select it.      
Select each UNIT from the list of “Available ENVIROMUX units” list that should be included in this group.  With the UNITs selected 
either:  

- click on “Save” to save the project, then “Cancel” to exit the project window,   

- click on  “New Group” to define another group of UNITs,  

- or just click “Cancel” to cancel the action, save nothing, and return to the empty “New Project” window.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                     Figure 17- Define a new project 

 
A unique name can be assigned to the Project.   
 
To change the Project name double-click on the name and type the new Project name.   
 
Press <Enter> to save it, or <Esc> to cancel.     
 
Perform the same steps to change Group names.  
 
 
 
 
 
 
 
 
 
 
 
 

Click “New Group” 
to add a group that 
will include some or 
all of the monitored 
units in the list.  



NTI ENVIROMUX-MNG Enterprise Environment Monitoring System Management Software 

 17

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                  Figure 18- Change names of project and groups  

 
If you apply a checkmark to the “Enable pop-up alerts when sensors go to Alert Mode” box,  then any sensor that calls for an alert 
will cause a pop-up on your computer screen and an audible indication as long as you are logged-into the client software.     
 
With the project settings defined, and groups defined, click on the group names to see the UNITs selected listed below each 
(Figure 19).    
 
Notice, below, that some UNITs in one group are also in the other.   A UNIT can belong to as many groups as desired.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                          Figure 19- Project and groups exploded to view UNITs 

 
 
 

Apply a checkmark if 
you want pop-ups for 
alert notices 

Select the units that will 
be included in the group 

Personalized note applied to pop-
up.  Can be unique for each user 
(see page 29) 
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1.  Select a UNIT to view the sensor category list.     
      2.  Select a category to see the sensors in that category.   
             3. Select a sensor to see the status of that sensor.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                             Figure 20- Exploded view of ENVIROMUX-MNG 

 

Open a Project 
In the image below, rather than creating a new project and re-selecting UNITs to be monitored, the user will open the “Guest 
View” project, a previously created project that contains all the UNITs the user wants to monitor.  
 
1. Go to the “File” menu and select “Open Project”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                                                Figure 21- Open existing project 

 
 

1. sensor categories

2. sensors in 
category

3. status of internal temperature 
(highlighted to the left) 
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2. A list of existing projects previously defined 
will appear.   Select the one desired and 
click “Open”.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                                             Figure 22- List of existing projects 

 
 
3. The selected project is now open and ready to review.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

                                                                            Figure 23- Existing project open, ready for viewing 

 

 
 
 
 
 
 
 
 
 
 
 

Click “Open” to open the pre-
defined “Guest View” Project 
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Delete a Project 
To delete a project, select “Manage Projects” (Figure 21) from the “File” menu.   Select the project name to remove and click the 
“Delete”: button.  That project and any groups defined within it will be removed from the projects list.  
 
FYI: The user can also open an existing project from the Manage Projects window, if desired.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                       Figure 24- Deleting a project
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Remote UNIT Management 
From the ENVIROMUX-MNG manager, the user can perform many UNIT management functions that otherwise can only be 
performed when connected to the individual UNIT through the web interface.   
To open a menu for making configuration changes to a UNIT, right click the UNIT name in the list.   From here, the following areas 
of a monitored UNIT can be managed:   
 
 View summary- to view a summary status of all connected 

sensors 

 View scrolling summary- to view a scrolling summary 
with a controlled window size of all or select categories of 
connected sensors 

 Configure System-  Fields for entering the time and date, 
language, and the LCD monitor settings for the UNIT being 
managed 

 Configure Enterprise- Fields for assigning the company 
name, address, contact person and phone number, and the 
UNIT e-mail address. 

 Configure Network- Fields for providing all the network 
settings  

 Configure Security- Apply SNMP agent settings 

 Users- Add and edit all user settings including passwords 
(available to users with administrative privileges only) 

 Configure Log- Define how log capacity will be handled 
and how user will be alerted as it becomes full 

  

                                                                                                           Figure 25- Options with right click on UNIT 

 
The management options of ENVIROMUX-MICRO-T(RHP) and ENVIROMUX-1W have a few differences: 
 
 View summary- to view a summary status of all 

connected sensors 

 View scrolling summary- to view a scrolling summary 
with a controlled window size of all or select categories of 
connected sensors 

 Configure Enterprise-  Field for entering the name of the 
E-Micro UNIT being managed 

 Configure Network- Fields for viewing all the network 
settings and changing the DNS server settings if desired. 

 Configure SNMP Agent- Apply SNMP agent settings 

 Configure Email Server- Apply email settings for the E-
Micro 

 Configure Time- Apply Date and Time settings for the E-
Micro 

 Users- Add and edit all user settings including passwords 
(available to users with administrative privileges only) 

 

 

                                                                            Figure 26- Options for the ENVIROMUX-MICRO and 1W UNITs 
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View Summary 
With the UNIT selected, right click and select “View Summary”  to see a summary view of the status of all sensors connected to a 
UNIT. 
 
 
 
 
 
 
 

 

 
 
 
 

 

 

 

                                                     Figure 27- Summary view of sensors in a UNIT 

 
 
 
If desired, the Summary view for each unit can be opened for easy monitoring.   They can be arranged in a “Cascade” view, like in 
Figure 27,   or in “Tile “ view,  like in Figure 28.    Simply select the summary view for each UNIT to be displayed, then select the 
view method.   The view methods of “Cascade” or “Tile” are found under the “Window” menu.    
 
 
 
 
 
 

 

 

 

 

 

 

                                               Figure 28- View multiple summary pages in Cascade View 

 
 
 
 
 
 

Change the view order  
by double-clicking the 
UNIT you want to see at 
the top of the list 

View methods:   
Cascade or Tile 
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                                             Figure 29- View summary pages in Tile View 

 
 
 
 

View Scrolling Summary 
 
The scrolling summary provides a more controlled way to limit the amount of screen space used for summary view and to view 
only those sensors that you want to keep on.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                   Figure 30- Scrolling window for controlled view of sensor status 

 
 
 
 

Click here to minimize a 
summary view 

Click here to close a 
summary view 

Use Filters to 
control which 
sensors will be 
viewed 

Change the 
number of rows 
viewed to 
control the 
window size 
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By applying limitations to the Filters (1-3), limit the view of the scrolled sensors to only those types of sensors you have an interest 
in seeing the information on.    The status of each is updated dynamically based on the configured refresh rate of each sensor. 
 
 
A scrolling summary can include only the sensors for a specific unit (as shown in Figure 29),  or, it can include sensors from an 
entire group of ENVIROMUXs (shown in Figure 31- Scrolling summary window can be used for a group of Units). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                      Figure 31- Scrolling summary window can be used for a group of Units 
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Configuration Options 
 
Click on “Configure System”, “Configure Enterprise”, “Configure Network” or “Configure Security” to access the configuration 
options of the ENVIROMUX you are managing.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                      Figure 32- Configure System and Enterprise Settings 
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                                                  Figure 33- Configure Network and Security Settings 

 
 

NOTE: SNMP must be enabled in 
each ENVIROMUX Unit monitored 
for the ENVIROMUX-MNG to receive 
and display sensor values. 
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ENVIROMUX-MICRO-T(RHP),-1W, and IPDU Configuration Options 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                               Figure 34- ENVIROMUX-MICRO-T(RHP) and -1W Configuration Options 
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User Configuration 
 
Click on “Users” to access individual user configurations within each ENVIROMUX.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                          

 

 

                                                                       Figure 35- Manage User Settings 

 
 
 
 
 

User Settings for ENVIROMUX-
MICRO,  IPDU and ENVIROMUX-1W 

User Settings for ENVIROMUX-MICRO 
and ENVIROMUX-1W 
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Log Configuration 
Click on “Configure Log” to control event  and data logging information for the connected UNITs.  (Not applicable to ENVIROMUX-
MICRO or ENVIROMUX-1W.)  Determine which sensor groups will generate logs, what types of information should be logged, 
how overflow is handled, and how users will be communicated with.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                          Figure 36- Configure Event Log Setup 
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ENVIROMUX-MNG Log Files 

Log files can be generated as they pertain to the events monitored by the ENVIROMUX-MNG software.  By configuring the 
sems.conf files found in the directories the Server and Client were extracted into, log files can be generated and then viewed for 
use in troubleshooting, generating reports,  or other programs intended to cause actions based on alert status.   

Server Logs 

Datalogs and alert logs on Server Software can be configured by editing “sems.conf “ file (using a text editor such as Notepad) 
below.  

Please note license activation is required to enable all logging features. 

syslogEnabled=true 

datalogEnabled=true 

syslogLevel=INFO 

devicePollRate=5000 

alertslogEnabled=true 

 

1. “Enabled” values can be set to “true” or '”false”. 

2. “syslogLevel” can be set to one of 'SEVERE', 'WARNING', 'INFO', 'FINE', 'ALL'.    Recommended Setting: INFO 

 SEVERE will log only system crash like messages.  
 WARNING will log severe messages and messages that user needs to look into 
 INFO will log all above messages plus some rudimentary messages like “server started” 
 FINE or ALL will log all communications and may generate several GB of data over a  few days  (not recommended) 

3. “devicePollRate” is the period between polling of sensors for same unit in milliseconds.  (1000 milliseconds = 1 second) Polling 
rate has to be between 900ms and 3,600,000ms. It can be adjusted based on refresh rate, data log rate #  required and system 
load on the server. 

4. When syslog is enabled, the Server software logs any errors and usage to a system.log file (in the same directory) which can 
be used for troubleshooting. 

5. When alertslog is enabled, the Server software logs sensor status changes to an alerts.log file in tab delimited format 
(example record given below): 

DATE_TIME                     LOG_LEVEL    ALERT_STATUS   ENVIROMUX_UNIT_ID   UNIT_IP_ADDRESS     UNIT_NAME         
SENSOR_TYPE   SENSOR_INDEX         SENSOR_NAME 

Mon Jul 31 10:08:04 EDT 2017    INFO          NORMAL           983168        192.168.3.100    ENVIROMUX-16D     
DIGITALOUTPUT    3            E-16D-M Door Strike 4 

 

6. When datalog is enabled, server software logs sensor data per device poll rate to 'data.log' in below tab delimited format 
(example record given). Sensor value may contain appropriate sensor unit separated by whitespace: 

 

DATE_TIME                        LOG_LEVEL     ENVIROMUX_UNIT_ID   UNIT_IP_ADDRESS     UNIT_NAME    
SENSOR_TYPE   SENSOR_INDEX         SENSOR_SNMP_OID                       SENSOR_NAME          SENSOR_VALUE 

Mon Jul 31 10:07:59 EDT 2017     INFO               1048667         192.168.3.217       E-5D-48V         
INTERNAL           0                 .1.3.6.1.4.1.3699.1.1.10.1.3.1.1.6.    Internal Temperature  32.8 °C 
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Client Logs 

Datalogs can be configured on Client Software can be configured by editing “sems.conf” file as below.  

Please note license activation is required to enable all logging features. 

 

syslogEnabled=true 

syslogLevel=INFO 

datalogEnabled=true 

1. “Enabled” values can be set to “true” or “false”. 

2. "syslogLevel" can be set to one of 'SEVERE', 'WARNING', 'INFO', 'FINE', 'ALL'.    Recommended Setting: INFO 
 

 SEVERE will log only system crash like messages.  
 WARNING will log severe messages and messages that user needs to look into 
 INFO will log all above messages plus some rudimentary messages like "server started" 
 FINE or ALL will log all communications and may generate several GB of data over a  few days  (not recommended) 

 

3. When syslog is enabled, the Client software logs any errors and usage to a system.log file (in the same directory) which can 
be used for troubleshooting. 

4. When datalog is enabled, the Client software logs only currently monitored sensor data, every 8-10 second, to “data.log” in 
tab delimited format (example record given below). Sensor value may contain appropriate sensor unit separated by whitespace: 

 

DATE_TIME                      LOG_LEVEL     ENVIROMUX_UNIT_ID   UNIT_IP_ADDRESS          UNIT_NAME                 
SENSOR_TYPE   SENSOR_INDEX         SENSOR_NAME              SENSOR_VALUE 

Mon Jul 31 10:08:06 EDT 2017     INFO             983168          192.168.3.100       ENVIROMUX-16D  Unit 1     
EXTERNAL          0                E-16D-M Temperature 1       83.1 °F 
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Sensor Monitoring and Configuration 
Sensor readings can be monitored, settings can be quickly configured to change the criteria for reporting alerts, or they can be 
removed altogether.  Right-click on a sensor to bring up a menu enabling you to Monitor, Configure, Remove a sensor, Start 
Recording sensor readings taken and View a History Graph of those readings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                 Figure 37- Manage a sensor- choose action 

Select “Monitor” to see the status of the sensor. 
 
 
 

 

 

 

 
 
 

 

 

                                                    Figure 38- Monitor status of the "Undefined" external sensor 

 

monitor, configure or remove a 
sensor for a monitored UNIT 

Be careful!   Don’t select “Remove” 
unless you really want the sensor 
removed.  To reinstate a sensor, you 
will need to reboot the UNIT (page 16). 
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Select “Start Recording” to have the readings for the sensor stored in memory.    Readings will be stored for up to 120 days, after 
which old readings will drop off to make room for new readings.  
 
To view the readings stored, select “View History Graph”.     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                      Figure 39- View History Graph 

 
A graph that shows a sensor’s readings can be viewed.   The time period displayed can be 
changed to show the last hour, last day, last week, last 30 days or the last 120 days.      
 
The color of the graph can be changed.   Click on “Color” to bring up a color chart.  Select 
the desired color and press “OK”.     (The color change will only take effect as long as you have 
the history graph open.   Once closed, upon reopening the graph the original color will be 
displayed again.) 
 
The range of readings displayed will adjust as the readings are taken.  For example, in the  
above image, for the time period displayed the range of readings was between 38.2°F.  to  
39.2°F.    If expanded to view the Last Day,   the range would automatically update 
to a wider range of temperatures and adjust the graph accordingly.  
 
If you right-click inside the graph, a menu with more options will be presented.   Click on “Properties”  
to bring up options to change the “Chart Properties” or appearance of the graph.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                Figure 40- Change the appearance of your graph (temporary) 

Note: The changes you make will only take 
effect until you close the graph.   Upon 
reopening the graph, the appearance will 
again be based on default settings.  
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To copy the graph image to your computer’s clipboard for pasting into another document, click 
“Copy”.     
 
To save the graph image as a .png image file on your computer, select “Save as….” .  
 
To send the graph image to a printer,   select “Print…”.    
 
To see greater detail in the graph, the range and/or domain axis can be zoomed in or out. 
To quickly return to a normal view of the graph, click on “Auto Range-Both Axes”. 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                   Figure 41- You can zoom your axes 

 

Another way to see greater detail is to select a specific area on the graph dragging from the top in a downward diagonal motion.       
When you let go of the mouse the graph will update with a closeup of the area you selected.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                       Figure 42- Drag a selected area to zoom in on 

 
To restore the default appearance of the graph, drag upward on the graph.

Range Axis 

Domain Axis 

Drag to select an 
area to zoom in on 

A closeup view of 
those readings will 
be presented. 
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Select “Configure” (from Figure 37) to configure the settings for that sensor.  
 
 
 

 

 

 

 

 

 

 
 
 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

                                       Figure 43- Configure the "Undefined" external sensor 

 
 
 
 
 
 

A note can accompany an alert message and be 
displayed in the Pop-Up message (Page 15, Figure 18) 
and on the sensor status window.   Each user can 
provide personalized content for each sensor.  
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                 Figure 44- Configure Temp. Sensor or Digital Input on ENVIROMUX-MICRO or -1W 

Respond to Alerts 
 
 
When an alert is present, the first screen in the project will indicate it by displaying the group name in red.  
 
 
 
 
 
 
 
 
 

                                                        Figure 45- Alert 1- Indication in group 

 
Click on the group name to see which UNIT is reporting an alert.  
 
 
 
 
 
 
 
 
 
 
 
Click on the E-SEMS to see which group of sensors the individual sensor is in.  
 

                                                           Figure 46- Alert 2- Indication of which UNIT 

Click on the UNIT to see which sensor category has an alert.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                       Figure 47- Alert 3- Indication of which sensor group 

 
 

group indicating an alert

E-SEMS that has a sensor 
reporting an alert 

An external sensor is 
reporting the alert 
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Click on the sensor group to see which sensor is in alert status.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                             Figure 48- Alert 4- Indication of which sensor is in alert 

 
Click on the sensor to see the status of the alert and be given opportunity to respond to the alert. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                   Figure 49- Alert 5- See the alert status 

 
With the sensor status returned to normal, the sensor tree returns to an alert-free appearance.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                         Figure 50- Alert 6- Alert has been acknowledge-status normal 

                            

This sensor is in alert
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Server Management from the Client 
If, at the login screen, you enter the username “root” and the password for root (default is “admin”), the program will open to an 
administrative menu that provides options for server management.   The server can be managed from the graphic interface 
provided by the server software, from the command line interface, or, in this case, through the client software.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                           Figure 51- Login as root from Client 

 
The menu for root includes only administrative functions.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Using these functions you can perform configure the server for password preference, adding, editing, or removing users, adding 
units, or activating the license.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                Figure 52- Manage Server from Client
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SOFTWARE UPDATE 
 
When newer versions of the ENVIROMUX-MNG become available, you may desire to update your client and/or server software.    
You will be notified by email that new versions are available, what changes were made to the software, and how to obtain updated 
software.    
 
To perform an update, simply unzip the new client (mng-clnt-vx-x.zip) or server (mng-srvr-vx-x.zip) software files into 
the same directory the present client or server files were installed to (see “Installation” on page 4).    
Do not delete any files.  None of your data, license, or configuration files will be affected.  Once the new files have been unzipped, 
simply open the client or server as normal (pages 38 and 14).   No additional changes or configuration are necessary.  
 
 
 

SETUP ENVIROMUX-MNG TO RUN AT STARTUP 
 
You may want to have the server that runs the ENVIROMUX-MNG server application to run the application automatically each 
time the server that hosts it powers ON.    The instruction below should assist you in setting this up.   
  
 
1. Create a batch file: SemsManagerSrvr.bat containing the following 2 lines: 
 
@ECHO OFF 
 
START "SEMS" /D"<PATH TO SEMS MANAGER SERVER>" "<PATH TO JAVA>" –jar SemsManagerSrvr.jar root 
admin 
 
2. Replace the 2 paths: 
 
PATH TO SEMS MANAGER SERVER = the path to the directory containing SemsManagerSrvr.jar (e.g. C:\Test Files\Server) 
 
PATH TO JAVA =the path to the Java Runtime executable (e.g. C:\Program Files\Java\jre7\bin\java) 
 
3. Replace the root password “admin” with the one you are using. 
 
 
EXAMPLE: START "SEMS" /D"\Test Files\Server" "\Program Files (x86)\Java\jre7\bin\java" -jar 
SemsManagerSrvr.jar root nti 
  
 
4. Depending on your operating system version, follow the instructions provided by the links to open the Group Policy Editor and 
add “SemsManagerSrvr.bat” as a startup script.  For Windows 2003, also enable the policy "Run startup scripts asynchronously". 
  

For Windows 2008 
 
1.   Open the Local Group Policy Editor:   http://technet.microsoft.com/en-us/library/cc731745.aspx 
2.   Assign Computer Startup Scripts:   http://technet.microsoft.com/en-us/library/cc770556.aspx 
 
 For Windows 2003 
 
1.   Open Group Policy as an MMC snap-in:     http://technet.microsoft.com/en-us/library/cc782895%28WS.10%29.aspx 
2.   Assign Computer Startup Scripts:    http://technet.microsoft.com/en-us/library/cc779329%28WS.10%29.aspx 
3.   Run startup scripts asynchronously:    http://msdn.microsoft.com/en-us/library/ms811602.aspx 
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TROUBLESHOOTING 
 
Problem:                                            
License key is not accepted.    When you enter the number and click “Activate”, nothing happens.             
 
Cause: 
The PC the server is installed on is running Windows 7 and has Java version 1.8 installed.   Java 1.8 will not allow the license to 
be installed. 
 
Solution: 
1. Uninstall Java version 1.8 from the Windows 7 PC.    Install Java version 1.7 instead.    
2. Deactivate User Account Control  (see page 7) 
3. Install the License key completely. 
4. Re-install Java version 1.8.  
5. If desired, reactivate User Account Control in Windows 7.  
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